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1 INTRODUCTION

The purpose of this manual is to demonstrate how to use the main features of the IDS
Multicriteria Assessor software, or IDS for short.

IDS is a general purpose multi-criteria decision support software developed on the
basis of the Evidential Reasoning (ER) approach. More information about the ER
approach can be found from the web site: www.e-ids.co.uk. More information about
MCDM problems can be found in sources such as http://www.terry.uga.edu/mecdm/.

IDS is different from most other MCDM software packages in that it can handle
different types of uncertainties, such as randomness, ambiguity and ignorance in an
integrated framework. It uses belief decision matrices to preserve information
structures in raw data and provides more informative outcomes. The following are
some of the main features available in the IDS Multicriteria Assessor.

e There are two different interfaces for building and viewing an attribute hierarchy.
One is in a drawing style and the other in the Windows Explorer style. For smaller
models, you can use the Drawing style. For large models, it is better to use the
Explorer view. The switch between the two views is by pressing the picture button

in the IDS main window (see Section 2.2.2 and Figure 2.2).

In either style, there is a TreeView for displaying the attribute hierarchy and a
ListView for all alternatives.

e There are different types of graphic displays for inspecting and reporting
outcomes such as ranking and performance distributions.

e Guidance, supporting information and comments can be stored and retrieved
whenever and wherever they are needed.

e The total number of attributes that can be used in an attribute hierarchy in this
academic version is limited to 200, but there is no limit (except for computer
space) in the corporate version of the software.

e Newly added alternatives can be assessed independently without affecting
previous assessment results.

Using IDS for MCDM problem analysis includes the following 4 major tasks.
e Modelling
e Data input
e Result reporting
e Sensitivity analysis

The information synthesis is handled by the built-in ER algorithm automatically and
you may not notice the calculation process. The following sections will describe how
to use IDS for fulfilling the 4 tasks in detail. It is worth mentioning that context
sensitive help can be activated by pressing F1 key in the keyboard whenever it is
needed when working in IDS windows. Also it is not necessary to read the whole
manual in order.


http://www.e-ids.co.uk/
http://www.terry.uga.edu/mcdm/

2 BUILD AN ATTRIBUTE HIERARCHY

2.1 Overview

This section describes how to model a MCDM problem using IDS. In IDS, the model
building process is related to the common features of assessing alternative courses of
action, or alternatives for short. It involves the following steps.

Step 1:  Identify an attribute hierarchy for assessing alternatives. This step requires
expert knowledge on alternatives to be assessed.

Step 2: Identify the types of BOTTOM level attributes. For example, is it
qualitative or quantitative? Note that this step only applies to BOTTOM
level attributes. Upper level attributes are always defined as qualitative in
the program.

Step 3:  For each QUANTITATIVE attribute, identify whether it is of probabilistic
nature. If yes, mark the attribute as uncertain.

Step 4: For each quantitative attribute, identify the unit and range of possible
values. For each qualitative attribute, define a set of grades to measure its
performances.

Step 5:  Define a value function for each attribute.

Step 6: Find out the relative importance of sub-attributes (children) to their upper
level attribute (father) using either Pairwise Comparison or Visual Scoring.

For illustration purpose, a real life example, the selection of motorcycles, will be used
to demonstrate the model building process in IDS. You can find the example in the
installation folder, which is by default “C:\Program Files\IDS Ltd\IDS Multicriteria
Assessor\Example\Motorcycle.ids”.

The attributes to consider for selecting a motorcycle are described in Figure 2.1. A
number given in brackets at the end of an attribute name in Figure 2.1 is a weight
assigned by a buyer, representing the relative importance of the attribute among a
group of attributes sharing the same immediate upper level attribute. Different groups
of attributes may use different scales for weight assignment. In the motorcycle
example, one group uses 0 to 100 as its scale and another group uses 0 to 1 as its
scale. It is not important what scale to use as long as a weight assigned to an attribute
reflects the relative importance of the attribute in comparison with the other attributes
in the same group.

Note that the attribute hierarchy constructed in Figure 2.1 is independent of any
specific model of motorcycles.



Level 1

Level 2

Price, £ (9)

Level 3

Displacement ¢ (5)

Range, miles (7)

Top Speed, mph (7)

Level 4

Responsiveness (0.2)

Fuel Consumption, mpg (0.4)

Engine (14)

Overall
Performance

Quietness (0.1)

Vibration (0.1)

Starting (0.2)

Steering (0.3)

Bumpy Bends (0.1)

Handling
(0.5)

Operation (7)

Transmission
(0.167)

Brakes
(0.333)

Feel At Control

Quality Of Finish (0.4)

Seat Comfort (0.3)

General (14)

Figure 2.1

Headlight (0.1)

Mirrors (0.1)

Horn (0.1)

Attribute Hierarchy for Motorcycle Selection




2.2 Model a MCDM Problem Using IDS
2.2.1 Start IDS Multicriteria Assessor (IDS.exe) Application

From the Taskbar of your PC, select Start -> All Programs -> IDS Multicriteria
Assessor program or double click the IDS Multicriteria Assessor shortcut .8 on your
Desktop if there is one. The programme “IDS.exe” can also be found in the directory
C:\Program Files\IDS Ltd\IDS Multicriteria Assessor if you used the default settings
to install the software.

By doing so, a window similar to Figure 2.2 will open. There is only one alternative
and one attribute initially. Note that in IDS all alternative boxes are marked yellow
and all attribute boxes are marked blue.

hﬁIDE—IntEIIigent Decision System for Multiple Criteria Asse ant - 105 =10l x|
File Edit Yiew Modeling Input Anakesis Report  Sensitivity  Window Help

D BB EDF D>Fwa & R0 P

wos: =10 x|
Alternative Name I i

—ZIFirst alternative

Far Help, press F1 [ ] | [n2fnafzons [12:17:5 4

Figure 2.2 A New IDS Model Window

2.2.2 Insert Attributes

Left click the mouse (we simply use “click” in the manual to represent a left click)
once anywhere on the top attribute, named Top Attribute by default, and then click the

blue arrow ﬂ on the Toolbar of IDS (Figure 2.2) to invoke the IDS Insert
Attributes dialog window (Figure 2.3). From the window, select the Insert right radio
button and then click the Confirm button once. Then select the Insert below radio
button and click the Confirm button 6 times. Now you should have an attribute
hierarchy with one top attribute and seven 2" level attributes (Figure 2.4).



IDS Dialog: Insert Attributes =|10] x|

Narme of the current attribute:
Total cost d

~Insert a new attribute around the current attribute -
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Insert |eft & Insert right

" Insert below

Help ' Confirm | Close

Figure 2.3 IDS Dialog: Insert Attributes

At the moment, each attribute is given a default name, Top Attribute, Attribute 1,
Attribute 2, ..., Attribute 7. They will be renamed later in Section 2.2.3.

If for any reason any attribute box needs to be deleted, it can be done by clicking
anywhere on the box and then the Cut % button on the Toolbar or by selecting the
Cut command from the Edit menu of the main window. It is also recommended to
save the model from time to time to avoid accidental loss of data.

File Edit Wiew Ml:n:lelllng Input  Analysis  Report Senmhwty '-.-'-.-'m-:h::w Help
SH| s RBEH D Ddwad RO
‘ =10l ]
[Alternative Name | [=
—IFirst alternative @ | - =) Attribute 1
..... = Attribute 2
..... =) Attribute 3
..... =) Attribute 4
..... = Attribute 5
..... = Attribute 6
..... =) Attribute 7
For Help, press F1 | | | [nzinafz008 [23:19:0 4

Figure 2.4  Attribute Hierarchy Skeleton

2.2.3 Define Top and Other Higher Level Attributes

Bottom level and higher level attributes are defined differently. To define a higher
level attributes, such as the top one, select the attribute by clicking on the attribute
box once (Figure 2.4) and then right click on the same box or click the £ icon (see



Figure 2.2) on the Toolbar. By doing so, the /DS Dialog: Define An Attribute window
will appear (Figure 2.5).

You can use the dialog window to define the attribute by providing the information
given in Table 2.1.

Table 2.1 Attribute Definition for Top Attribute or Higher Level Attributes

Item

Information
Requested

Values
Provided

Comments

Attribute
Name

Overall
Performance

Type in the attribute name in this field. If you
wish to provide more information about the
attribute, you can click the Describe (Figure 2.5)
button, which will invoke an interface for you to
enter text information.

Attribute
Type

Qualitative

Any higher level attribute (an attribute with child
attributes in the hierarchy) is always defined as a
Qualitative type, while a bottom level attribute
can be either Qualitative or Quantitative.

Number of
Grades:

When an attribute is defined as a Qualitative type,
you may wish to specify the number of grades to
be used for assessing the attribute. You may
change the number at any time when necessary.
The name of the grades can also be changed if
necessary (see next item below).

Define Grades
Now?

Yes/No

If you select Yes, you will see a window similar
to (Figure 2.6). You can change the default grade
names and also the utility/value score associated
with each grade in the window. The higher the
score, the more preferred the grade is.

If you wish to provide explanations or standards
for a grade, you can click on the grade name and
then the Define button in the window (Figure
2.6). The grade definition you enter here will
appear later to guide the assessment of an
alternative on this attribute [refer to Section 4.5
for details].

Advanced
(button)

When the Advanced button is clicked (not
applicable to the top attribute), the marked area
(Figure 2.7) on the left side of the button will
appear (see below). You may leave this button
alone, which implies that the value function for
this attribute is assumed to be linear by default.

Rule or Utility
(button)

You may specify how the value/utility function of
this attribute is related to that of its father
attribute. You can choose either Rule or Utility.
The difference is explained in Section 2.3.




IDS Dialog: Define An Attribute ] = |EI|5I
op Attribute -l
=
Attribute Type: Quantitative or Qualitative aK
© Gugmtiatiyve = Qualitative —
Murnber of Grades: Cancel
|5
Describe
Define Grades Now?
Yes | No Help
Figure 2.5 Define A Qualitative Attribute
1DS Dialog: Define Evaluation Grades N x|
Define Evaluation Grades and Assign Utilities If Necessary for
Crherall Pedormance ;l
I7]
Grade Mame Utility [0 1]
Grade 1 [islsl} ||] j Help |
Grade 2 [Indifferent [ozs -
Grade 3 |Average o5 Sl |
Grade 4 |Good ||:|.?5 j

Grade § [Excellent |‘| j
Cancel |

Figure 2.6 Define Evaluation Grades

2.2.4 Define A Bottom Level Attribute

When defining a bottom level attribute, you have the choice to define it either as a
Qualitative type or Quantitative type.

2.2.4.1 Define Qualitative Attributes

Qualitative bottom level attributes are defined in the same way as defining the upper
level attributes such as the Overall Performance attribute (Table 2.1).
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2.2.4.2 Define Quantitative Attributes

To define a quantitative attribute, such as Price, involves the following steps:

Select the attribute you wish to define by clicking on the attribute box,
Attribute 1 (Figure 2.4)

Right click on the box or click the "%l icon on the Toolbar (Figure 2.4) to open
the IDS Dialog: Define An Attribute window

From the dialogue window, click the Quantitative radio button (Figure 2.7)

Use the dialog window to define the attribute by providing the information
given in Table 2.2.

Follow similar procedures as above, the other quantitative attributes Displacement,
Range and Top Speed can be defined by using the information provided in Table 2.3.

IDS Dialog: Define An Attribute =100 .=l

Attribute |Price =
MName:
id
Aftribute Type: Quantitative or Gualitative aK
& Quantitative ~ Qualitative —
™ Uncertain Cancel
BestWalue: ‘Worstvalue: Dastribs
|5000 |9000 —
Unit: |£ Help
i I Advanced

GE ot

Figure 2.7 Define A Qualitative Attribute

2.2.5 Complete the Rest of the Model

By following the instructions detailed in the above four sections, other attributes can
be added and defined. Save the built model by pressing the [ button on the toolbar,
use a meaningful file name, such as MotorcycleSelection.ids. The file will be given an
extension “.ids” and you will be able to open it by double clicking it later. The
complete IDS model of the motorcycle selection problem looks like the one shown in
Figure 2.8.

11



Table 2.2

Attribute Definition for Price

Item

Information
Requested

Values
Provided

Comments

Attribute
Name

Price

You type in the attribute name in this field. If
you wish to provide more information about
the attribute name and its meaning, you can use
the Describe (Figure 2.5 or Figure 2.7) button
to type in any explanation text.

Attribute
Type

Quantitative

By nature the Price attribute is quantitative and
assessed numerically.

When an attribute is quantitative, it could be
uncertain, such as random distribution or even
unknown (partially or completely). For
example, the fuel consumption rate of a
motorcycle changes with weather and road
conditions. Its user may states that 70% of the
time it will be used on motorways and 30% on
urban road. Therefore the Fuel Consumption
attribute may be defined as uncertain by
selecting the Uncertain radio button in the
window.

Best value

5000

The lowest price you wish to pay or available
for the product range.

Worst Value

9000

The highest price you wish to pay or available
for the product range.

Unit

The unit for the attribute value, the Best Value
or the Worst Value.

Advanced
(button)

When the Advanced button is clicked, the
marked area on the left side of the button will
appear (see below). You may leave this button
alone which implies that the value function for
this attribute is assumed to be linear by default.

Rule or
Utility
(button)

You may specify how the value/utility function
of this attribute is related to that of its father
attribute. You can choose either Rule or Utility.
The difference is explained in Section 2.3.

12
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Figure 2.8 IDS Model of the Motorcycle Selection Problem

2.2.6 Import An Existing IDS Model

At times you may wish to incorporate previously saved IDS models (files with the
extension .ids) into the current model. This happens when the old attribute hierarchy
in the previous model can be used as a sub model of the current model.

To do so, you should click on the attribute where you wish to add the pre-built model,
and then select from the menu bar of the main window Modelling->Attribute->Add
from IDS File (Figure 2.9). You will then be asked to browse and add the IDS model
file (Figure 2.10). As soon as you click the Add button (Figure 2.10), the model will
be inserted under the selected attribute. If you are not happy with position where the
model is added, you can use the # button to cut the unwanted attributes, or simply do
not save and re-do the importing at a different location.

13
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Figure 2.9 Import Previously Built IDS Multicriteria Assessor Model

IDS Dialog: Add Attributes from A File } x|

Enter the name of a file, or browse the directory hierarchy ta find the file name.

CAProgram Filesh DS Lidy DS Multicriteria AssessonExample\Car.ids

Browse ... Add | Help | Cancel

Figure 2.10 Browse and Add the Existing IDS Model

2.3 Convert Values or Grades of Attributes

In the attribute definition dialog (Figure 2.5 and Figure 2.7), you are asked whether
the attribute to be defined is related to its father attribute based on rule or utility. This
section will explain what the difference is between the two. It is an advanced feature
of the IDS. You may skip answering the question if you are not sure how to handle it.
By default, the IDS program will assume a linear value or utility function for each
attribute.

2.3.1 Relate a Quantitative Attribute to Its Father Attribute

This sub section describes how to convert a quantitative attribute value to the grades
of its father attribute. For qualitative attributes, it is described in the next sub section.

In the motorcycle selection problem, the Overall Performance of a motorcycle is
determined by its 7 sub-attributes. The Overall Performance is assessed by 5 grades:
Excellent, Good, Average, Indifferent and Poor. One of its sub-attributes, Price for
example, is assessed numerically in pound sterling. You may ask how to relate Price
to its father attribute Overall Performance, in another word, how to assess the Overall
Performance as far as Price is concerned? There are two techniques to convert values
of an attribute to its father’s grades, one based on rules and the other on utilities or
values.

14



2.3.1.1 Rule Based Approach

One way is to convert Price into the 5 grades used in its father attribute assessment.
The decision makers is expected to provide equivalence rules to relate each
evaluation grade of the Overall Performance to a particular Price. For example,
according to the decision makers’ knowledge, s/he may define the following rules:

Rule 1. If Price is £5000, then Overall Performance is Excellent as far as
Price is concerned.

Rule 2. If Price is £6500, then Overall Performance is Good as far as Price
is concerned.

Rule 3. If Price is £7500, then Overall Performance is Average as far as
Price is concerned.

Rule 4. If Price is £8500, then Overall Performance is Indifferent as far as
Price is concerned.

Rule 5. If Price is £9000, then Overall Performance is Poor as far as Price
is concerned.

This is the so-called rule based approach. If you prefer to relate Price to Overall
Performance by rules, then you should select the Rule button when defining the Price
attribute using the dialog box shown in Figure 2.7. After the Rule button is selected,
you can then select from the main menu of the IDS window Modelling->Convert
Values to pop up the IDS Dialog: Convert Child Attribute’s Values (or Grades) to Its
Father’s Grades (Figure 2.11). From this dialog, you can input the rules.

IDS Dialog: Convert Child Attribute’s Yalues to Its Father's Grades

Child Attribute |price
Mame:

Father Attribute |Cwverall Pedormance
Mame:

(Associate a numerical value of the abowve quantitative child About Father
aftribute to each evaluation grade of its father aftribute )

Bestalue of Child Attribute: (5000 About Child
‘WaorstWalue of Child Attribute; [9000

Marme of Father Grade: Child “alue:
Poorm Cancel
Indifferent |5000 ~
Awrerage 7000 Help
Good (6000
Excellent {2000 “Walue Unit

About Grade

(kL

Comments

Figure 2.11 Convert Child Attribute’s Value to Its Father Grades
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2.3.1.2 Utility Based Approach

Another way is the so-called utility or value based approach. You can choose this
method if you can express your preferences towards different attribute values by
numbers in [0, 1], with 1 representing the most favourable and O the least. These
numbers are normally referred to as utilities or values, depending upon how they

are generated.

HIDS - Intelligent Decision System for Multiple Criteria

File Edit Wiew | Modeling Input  Analysis Report  Sensitiviey  Window  Help

=101 x|

@ | o Arbute M dwa| A R B b
Alternative EE
m Model Bilder =]
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Select Methods

4l

| 9|

=IYamaha Estimate Lkility
ZIHonda Change Grade Mame Direct Assignment
=IBMWY Conyert Grades Yisual Scoring
Conyvert Yalues R
: 1gine
-0 Operation
-0 General

%

Figure 2.12 Use the Modelling Menu to Assign Attribute Utility

In the case of the Price attribute, suppose your preference is represented by Table 2.5.
You can input the preference information in IDS as follows.

o Click the Utility option in the Define An Attribute dialog window (Figure 2.7)

e From the Modelling menu (Figure 2.12) select Estimate Utility then Direct
Assignment or Visual Scoring to activate an IDS Dialog window similar to
Figure 2.13 if Direct Assignment is selected or Figure 2.14 if Visual Scoring

1s selected

e Modify utilities/values and their corresponding attribute values as necessary
from the dialog window shown in Figure 2.13 (for Direct Assignment) or drag
and drop the marked point on the utility/value function curve to the desired
position (Figure 2.14) (for Visual Scoring).

Table 2.5  Utilities Assigned to the Price Attribute
Attribute Value (Price in £) | Utility (Preference degree)
9000 0.00
8500 0.25
7500 0.50
6500 0.75
5000 1.00

16



2.3.1.3 Let IDS Decide

If there is no rule or utility (preference) information available to convert the child
attribute values to its father grades, IDS will use the rule based approach and assign
the father grades to the range of the child attribute values in equal distance. For
example, in the case of the Price attribute, IDS would relate Poor to £9000,
Indifferent to £8000, Average to £7000, Good to £6000, and Excellent to £6000.
Therefore if you are not sure whether to use rule based or utility base approach, you
may answer No when you are asked whether to convert the values.

If you choose the utility based approach, IDS will also assign the initial utilities for
you assuming a linear relationship between the utility range [0,1] and the attribute
value range, [9000, 5000], for example in the case of the Price attribute. If it is
acceptable, you need do nothing else. Otherwise you can use the dialog window
shown in Figure 2.13 to modify the values.

IDS Dialog: Assign Utilities for A Quantitaktive Al EI

Azzign utilities to the typical attribute values for

Frice

: [Itility Mo

Best Attribute YW alle: IEEIEIEI
o =
Wforst Attribute Walle: IEIEIEIEI & 5 |
£ 8 |

Walue [litg [0 1]

3000 [ =l
8500 0.25 | Help
7500 0.5 =]
B500 0.75 j Comments
5000 1 =l

oK

Cancel |

Figure 2.13 Assign Utilities/Values to Attribute Values by Direct
Assignment
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Figure 2.14 Assign Utilities/Values to Attribute Values by Visual Scoring

2.3.2 Relate a Qualitative Attribute to Its Father Attribute

If a child attribute is qualitative, IDS allows the attribute to be assessed using a
different set of grades from its father’s to facilitate data collection. When this is the
case, we will demonstrate how the rule and utility based approaches can be applied to
relate the grades of the child attribute to those of its father attribute.

2.3.2.1 Rule Based Approach

In the motorcycle selection problem, for example, if the Engine attribute is assessed
by 6 grades {Best, Very Good, Good, Average, Poor, Worst}, to use the rule based
approach, the decision maker should provide equivalence rules to relate each
evaluation grade for assessing Engine to all the grades for Overall Performance. For
example, according to the decision maker’s knowledge, s’/he may define the following
6 rules, one for each of the 6 grades of Engine:

Rule 1. If Engine is the Worst, then Overall Performance is

0% Excellent
0% Good

0% Average
0% Indifferent
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100% Poor
as far as Engine is concerned.

Rule 2. If Engine is Poor, then Overall Performance is

0% Excellent

0% Good

0% Average

80% Indifferent

20% Poor

as far as Engine is concerned.

Rule 3. If Engine is Average, then Overall Performance is

0% Excellent

0% Good

60% Average

40% Indifferent

0% Poor

as far as Engine is concerned.

Rule 4. If Engine is Good, then Overall Performance is

0% Excellent

40% Good

60% Average

0% Indifferent

0% Poor

as far as Engine is concerned.

Rule 5. If Engine is Very Good, then Overall Performance is

20% Excellent

80% Good

0% Average

0% Indifferent

0% Poor

as far as Engine is concerned.

Rule 6. If Engine is Best, then Overall Performance is

100% Excellent

0% Good

0% Average

0% Indifferent

0% Poor

as far as Engine is concerned.

To relate the grades of Engine to those of Overall Performance using the rules, follow
the following steps:

Click and then right click on the Engine attribute from the attribute hierarchy
(Figure 2.8). When the attribute definition window similar to Figure 2.5 is
displayed, change the Number of Grades to 6,

Click the Advanced button to reveal the Rule and Utility buttons,
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Click the Rule button. If you are asked “Do you want to change grade
conversion rules?” we normally recommend you to answer No, but in this case
you should answer Yes.

If you are asked “Do you want to change grade conversion rules?” we
normally recommend you to answer No, but in this case you should answer
Yes. At this point, you will see a window shown in Figure 15 for you to
rename the grade names. Rename the 6 grades and then click OK.

When asked whether to convert grades manually (Figure 16), answer Yes and
the IDS Dialog window similar to Figure 2.17 will be displayed. The window
displays the program default conversion for Rule 1. You may modify it
accordingly to the new rule above. When it is done and you click the OK
button in the window, the current window will close and another similar
window will pop up for you to view or modify another rule. The process
continues until all the 6 rules are viewed or changed.

If you wish to change the conversion at any time later, you can invoke the /DS
Dialog: Convert Child Grades to Father Grades (Figure 2.17) by selecting
Modelling->Convert Grades from the main menu of the IDS window.

x
Ciefine Evaluation Grades and Assign Utilities If Necessary for

Engine =

hd
Grade Mame Utilite [0 1]

Grade 1 aE i j Help |
Grade 2 [Foor 02 j

Grade 3 Awerange 0.4 = Bl |
Grade 4 [Good 0k B
Grade & Best 0g -

Grade B [New name 1 z

N

Cancel

Figure 2.15 IDS Dialog for Defining Grades

s x|

9P ¥ou have modified the evaluation grades for the Following atkribute:
- <Engine =,
These grades need ko be converted ta the grades aof its Father attribute,

Tao carvert manually, click Yes,
To accept defaulk conversion, click Mo,

Figure 2.16 IDS Dialogue for Confirming Manual Grade Conversion



From the procedure shown above, we can see that it is better not to change the
assessment grades frequently, especially the grades of those attributes at a high level
in the attribute hierarchy.

Fortunately, if you have to change assessment grades for some attributes, IDS
provides default conversion rules for you. The default conversion assumes that any set
of assessment grades is equal distance distributed in the utility/value range [0,1],
which is reasonable and most commonly used.

As mentioned earlier, the above conversion procedures are for illustration purpose and
not really required in the motorcycle example. You can find the example in the
installation folder.

IDS Dialog: Convert Child Grades to Father Grades

Father Attribute Name: |Top Attribute

Child Aftribute Name: |[Engine

Marne of Child Grade: Father Attribite
Wiorst
Child Aftribute
Iz equivalentto
Belief Degree
Marme of Father Grade: m 1 Ok
| Wclrst j
| PDDr!D = Cancel
| Average!ﬂ j
Good |0 - HEp
Best|0 i

Child Grade

Father Grade

Comments

AN N

Figure 2.17 Covert Child Grade to Father Grade by Rules

2.3.2.2 Utility Based Approach

Another way is the so-called utility based approach. You can choose this method if
you can express your preferences towards different grades by numbers in the
utility/value space [0, 1], with 1 representing the most favourable and O the least.
Again we use the Engine attribute as an example and assume it was assessed by 5
grades before and is now by 6 grades.

To use this method to conduct the grade conversion between Engine and its father
attribute and between Engine and its children,

e Click and then right click on the Engine attribute from the attribute hierarchy
(Figure 2.8). When the attribute definition window similar to Figure 2.5 is
displayed, change the Number of Grades to 6,

[\S}
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Click the Advanced button (Figure 2.7) to show the Rule and Utility buttons,

Click the Utility button. If you are asked “Do you want to estimate attribute
utilities?” we normally recommend you to answer No, but in this case you
should answer Yes.

At this point, a dialog window shown in Figure 2.18 will pop up for you to
select a method to assign utility to each grade. You may select Direct
Assignment or Visual Scoring, which will activate a window similar to Figure
2.19 if Direct Assignment or Figure 2.14 if Visual Scoring is selected. It
basically gives you another chance to edit the utilities you have assigned to
each assessment grade of Engine. You will not see the grade by grade
conversion process as shown in the rule based approach. It is because by using
the utility based approach, the father’s grades and child’s grades are all
represented by utilities, which is in a common space of [0, 1]. It implies that
the conversion is already implemented through the utility assignment and an
conversion matrix is generated internally by IDS.

If you wish to change the conversion of Engine at any time later, you can click
on the Engine attribute box (Figure 2.8) and then select Modelling->Estimate
Utilities->Direct Assignment or Visual Scoring from the main menu of the
IDS window.

ID% Dialog: Select A Method for Estimating Ukilities ﬂ

—Select ane of the following methods

&+ Wisual Scoring

" Direct Assignment

7 Erabability Assignment
O Alternative Companso

7 Beterence Assignment

el | gelect ............. e

Figure 2.18 Covert Child Grade to Father Grade by Rules
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Grade 4 Good 0 LI
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Cancel |

Figure 2.19 Define Evaluation Grades and Assign Ultilities

3 ASSIGNING WEIGHTS

Having defined all attributes, the next task is to assign a weight to each attribute. A
weight should reflect the relative importance of each child attribute to the evaluation
of its father attribute. Therefore when assigning weights, each time you only need to
look at a small group of attributes which share the same father attribute.

At the start, IDS automatically assigns a weight to every attribute, assuming that all
attributes are equally important.

In the motorcycle selection problem, there are 7 groups of attributes as shown in
Table 3.1. Different groups can use different scales for their weights.

Table 3.1  Weight Assigned to Each Attributes
Group | Father Attribute Child Attributes in the Group with Weights in Brackets
of the Group
1 Overall Price (9), Displacement (5), Range (7), Top Speed (7), Engine
Performance (14), Operation (7) and General (14)

2 Engine Responsiveness (0.2), Fuel Consumption (0.4), Quietness (0.1),
Vibration (0.1), Starting (0.2)

3 Operation Handling (0.5), Transmission (0.167), Brakes (0.333)

4 General Quality of Finish (0.4), Seat Comfort (0.3), Headlight (0.1),
Mirrors (0.1), Horn (0.1)

5 Handling Steering (0.3), Bump Bends (0.1), Manoeuvrability (0.4), Top
Speed Stability (0.3)

6 Transmission Clutch Operation (0.5), Gearbox Operation (0.5)

7 Brakes Stopping Power (0.4), Braking Stability (0.3), Feel at Control
(0.3)

I

IDS provides two ways to help you to assign weights systematically: visual scoring
and pairwise comparison.
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3.1 Visual Scoring
The first method is Visual Scoring. To use the method,

(1) Click any attribute of the group you wish to assign weights to (refer to Figure
2.8).

(2) Click the shortcut icon # (the w here stands for Weight) from the toolbar of the
IDS main window, and then the Visual Scoring radio button and the Select button
on the IDS Dialog: Select A Method for Assigning Weights (Figure 3.1).
Alternatively, from Modelling menu of the IDS main window select Estimate
Weight and then select Visual Scoring. This will invoke the dialog window shown
in Figure 3.2.

IDS Dialog: Select A Method for Assigning Weights x|

—oelecta method for weight assignment

& “isual scoring

" Pairwise comparisons of attributes

Cancel Help

Figure 3.1 Select A Method for Assigning Weight

(3) In the dialog window shown in Figure 3.2, the weight of each attribute in the
group is displayed graphically. The relative importance of each attribute is
represented by the height of its column. To change the weight of an attribute, you
can use a computer mouse to drag the top edge of its column up and down until it
reaches the desired height. During the dragging process, the weights are displayed
at the top of each column dynamically.

You can choose any of the 3 scales: [0, 1], [0, 10] or [0, 100] for assigning
weights. You can also change scales at any time. When you change scales, the
ratio of any two attribute weights will be maintained and the assessment results
will not be affected.

You can also use a normalised scale. If weights are normalised, the total sum of
the normalised weights in a group will be 1 if the scale [0, 1] is used, 10 or 100 if
[0, 10] or [0, 100] is chosen respectively.

If you change any of the weights using the drag and drop function and the weights
are not normalised, the rest of the weights will not change. If the weights are
normalised, the rest of the weights in the group will also change automatically in
order to keep the total sum at a fixed number, 1, 10, or 100. However, the ratio
between any two will be maintained during the process.

At the bottom of the window (Figure 3.2), there is also a list view to list all
attributes in a group and their weights. By clicking on any of the attribute name in
the list, you can type in a weight value from the edit box just above the list. This is
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IDS

a better way for assigning weights than the dragging and dropping graph bars if
you want to assign weights precisely.

When you are happy with weights assigned to all attributes in a group, you can
click on the Confirm Weights button to accept the assigned weights. If you are not
happy with all the changes you have made since last time you have pressed the
Confirm Weights button or from when the window shown in Figure 3.2 was
invoked, then you can press the Restart button to start from the previous weight
setting again until you are happy with the new setting.

Dialog: Assign Attribute Weights by Yizual Scoring

—5Scale ~Shle
C Oneld 1] & Hunded[d 100 | C Homsised Confim | __Somerts | e | o |
© Ten(0 10] & Mot Nomalised || Weioht Bestat | ToolBar | Cance
Relative Weights of Attributes
100.00
90.00
a0.00
w7000
5 B0.00
© 5000-
g 40.00 -
30.00 -
20.00 -
10.00 ' 7.00 / /
0.00 P— i i ] T ;
Price Dizplacement Range Top zpeed Engine Cperation General
Attributes
Selected Athibute Mame: ‘wieight:
|F'riu:e
Attribute name | weight |
=) Price 5.000000
= Displacement 5.0000a0
=|Range 7000000
=i Top speed 7.000000
=—IEngine 14.000000
=] Operation 7.0000a0
=| General 14.000000
Figure 3.2 Assigning Attribute Weights by Visual Scoring
3.2 Pairwise Comparison
The second method is Pairwise Comparison. Users who know the AHP (Analytical

Hierarchy Process) method may find this method familiar. To use this method,

(1
)

Click any attribute of a group you wish to assign weights to (refer to Figure 2.8).

Click the shortcut icon # from the toolbar of the IDS main window, and then
click the Pairwise Comparison radio button and then Select button on the /DS
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Dialog: Select A Method for Assigning Weights (Figure 3.1). Alternatively, from
the Modelling menu of the IDS main window select Estimate Weight and then
Pairwise Comparison. This will activate the dialog window similar to Figure 3.3.

IDS Dhalog: Aszsign Weights Using Pairmise Companisons
| evaluation of the following Father attribute

Matarcpcle zelection

Compare the relative importance of a selected child attribute with the ather child attributes in the following painsize fashion

Attribute

[PnR [ placement Canfirm zelection | Help I ]9 |
times az important as [EetfEemEansat Comments | Cancel |
Attribuke
Compared to: General —Weight generation method —
: 2 ; ' Geometric Mean
Provided Painmize Comparisons: : I =
g Calculate weights % Eigerwector [8HP]
Attribute Selected | times a.i.a. I Attribute Compared to |  Miced & "
—|Price 1.800000  Dizplacement Generated Weights: e AppoAan
Z‘—'i F'rfce s Skhios Attribute name I Weight]
= E'Fe ;Eig;g; E”':'_Sp%d = Piice 3000000
= P’!Ce e D”E"”e_ =] Displacement £.000000
Bl Price : petatiori BB Range 7.000000
= E'_'Cel gg;‘ig:g gene'a' =] Top speed 7.000000
= D!*':'lacement i ANas ; =] Engine 14.000000
B Displacement ; ORSRES =) Dperation 7.000000
=l D!splacement 0.357143 Englne. ) General 14.000000
= Displacement 0714286 Operation
= | Dizplacement 0357142 General

; Inconsistence ;
Clear all compansnn&l o IU Advice I

Assigning Attribute Weights by Pairwise Comparison

Figure 3.3

(3) In the dialog window shown in Figure 3.3, from the Attribute Selected drop down
list, select an attribute (Displacement in the example of Figure 3.3) and then press
the Confirm selection button. As soon as the button is pressed, the Confirm
comparison button is enabled and so does the ratio drop down list on the left side
of the Confirm comparison button. The ratio 0.357143 in the example of Figure
3.3 can be edited and indicates that Displacement is 0.357143 times as important
as the General attribute. General is the attribute name shown below the ratio drop
down list in the field Attribute Compared to. If you are happy with the ratio
displayed in the ratio drop down list, you should click the Confirm comparison
button to save the change and move to the next pairwise comparison. The attribute
name in the Attribute Compared to field changes each time you press the Confirm
comparison button until all attributes in the group have been compared with
Displacement once. When it is done, the results will be added to the list displayed
in the left bottom pane of the window (Figure 3.3). Next, you may choose another
attribute from the Attribute Selected drop down list and repeat the above process
until all possible pairs in the group are compared. In total there are (N> — N)/2
possible pairs.
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It is not compulsory to compare all the (N> — N)/2 pairs. The minimum
requirement is that you should at least compare one attribute with the rest of the
attributes in the group once. For example, if you choose Price, you should
compare at lease the following 6 pairs (Price, Displacement), (Price, Range),
(Price, Top Speed), (Price, Engine), (Price, Operation), and (Price, General).

If you provide only minimum information, IDS will work out the relative
importance of all the pairs. If you provide more information than minimum, then
IDS will use the redundant information for consistency test. The inconsistence
index is displayed at the bottom on the same window (Figure 3.3). More
information about the inconsistence index is discussed below.

(4) The results for the compared pairs are listed in the left bottom pane of the window
shown in Figure 3.3. If you are not happy with any of the results, you can use the
process stated above to make changes. Once you are happy with the comparison,
you can click the Calculate weights button. The calculated weights are displayed
in the bottom right pane of the window shown in Figure 3.3.

There are 3 methods to calculate weights from pairwise comparisons: Geometric
Mean, Eigenvector and Mixed Approach. You can use any of them. The Mixed
Approach takes the average of the weights generated by both Geometric Mean and
Eigenvector methods. The detailed description of the two methods is out of the
scope of the manual and could be found in the latest books on multiple criteria
decision analysis.

Below the weight pane, the inconsistence index is also displayed. If all
comparisons are completely consistent, the inconsistence index will be zero and
vice versa. In this case, the weights generated using any of the three methods will
be the same. This will happen if only minimum information is used, that is only
one attribute is selected to compare with all other attributes and only these
comparisons are used to generate weights, as discussed in point (3) above. If the
inconsistence index is

e less than 0.01, the comparisons can be regarded sufficiently consistent. In this
case, the weights generated using the three methods should be very similar. If
the inconsistence index is

e less than 0.1 but larger than 0.01, the comparisons can be regarded reasonably
consistent. In this case, the weights generated using the three methods may be
slightly different. You could choose the weights generated using one of the
three methods that you prefer. If the inconsistence index is

e larger than 0.1, the comparisons may involve considerable inconsistency. If the
weights generated using the three methods are noticeably different, then the
comparisons may need to be modified. If this is not possible, the mixed
approach could be used to generate a set of average weights.

3.3 Visual Scoring vs Pairwise Comparison

The pairwise comparison method is sometimes called AHP (Analytical Hierarchy
Process) method because it is the core element of the AHP method. Pairwise
comparison is more complicated than the visual scoring method and may not
necessarily produce a better set of weights. For this reason, we recommend to use
visual scoring, especially for beginners. For people who know AHP very well,
pairwise comparison provides an alternative way for generating weights.
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4 USING IDS MODEL FOR DATA COLLECTION

4.1 Overview

In a multicriteria analysis, an alternative needs to be assessed on each attributes in the
bottom level of the attribute hierarchy. This section describes how to collect and
record assessment information for each alternative on each bottom level attribute and
how to record uncertainties in assessment.

4.2 Add and Define an Alternative

To use the model for assessing an alternative, you need to add and define an
alternative. It is easy to add an alternative. You first click anywhere in the left pane of
the IDS Multicriteria Assessor main window (Figure 2.2), and then click the =)
command button on the toolbar. A new alternative will be added with a default name
Alternative n.

When you first use the model, there is an alternative already in the left pane of the
main window with a name First Alternative. You may rename it and use it.

To define an alternative in most cases is simply to rename the alternative. To define it,
you need to click on the alternative box and then right click it. You will see a dialog
box similar to one shown in Figure 4.1. You can then change the name in the space
provided. If you wish to provide more detailed description about this alternative, you
can do so by clicking the Describe button in the same window.

IDS Dialog: Define An Alternative : x|

Alternatree Name:

Altarmative 3

| |

Ok Cancel Describe Help |

Figure 4.1 Define An Alternative

To input and record assessment information, click the alternative box (in the left pane)
once to select it and double click on the bottom level attributes, one at a time to input
assessment information and all information you enter (as explained in the next
section) will be associated with this alternative. The alternative will remain selected
as long as you do not click on any other alternatives. If you have navigated away from
this alternative, you should navigate back by clicking it again once before you enter
any information for it.

You should also save your work from time to time.
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4.3 Data Input for Quantitative Attributes without Uncertainty

To record assessment information in the IDS model, first you need to make sure the
targeted alternative is highlighted. If not, you can click it once to highlight it.

If an attribute is defined as Quantitative (refer to Table 2.2), double clicking on it will
activate a dialog window similar to Figure 4.2. For example, the Price for Yamaha is
£5199. You simply type the price in the space provided in the window.

ID% Dialog: Overall Performance N ﬂ
Altermative Name: IYamaha
Aftribute Mame: [Frice LI
How to Assess | O,
Agsessment Walue: |ERESE Cancel
Best Aftribute Yalue: Help

YWorst Aftribute Value: Attribute Definition

Aftribute Linit, £

Alternative Definition

Provide Comments

Figure 4.2 Input Assessment Data for Quantitative Attributes

4.4 Data Input for Quantitative Attributes with Uncertainty

If an attribute is defined as Quantitative with uncertainty (Table 2.2), double clicking
on it will activate a dialog window similar to Figure 4.3. For example, the fuel
consumption rate of a motorcycle measured by miles per gallon changes with weather
and road conditions. If its user states that 70% of the time it will run on motorways
and 30% on urban streets, you should enter 2 in the field “The Number of Possible
Values” in Figure 4.3, one for motorways and the other for urban streets. The
maximum number of possible values the current version of IDS can handle is 20. If
you wish to use a number larger than 20, please email us at info@e-ids.co.uk.

Other buttons in this window are mainly used for providing help and other
information to assist the assessment. Details on the function of each button in this
window are given in Table 4.1.
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Figure 4.3

IDS Dialog: Engine N ﬂ

Alternative Name: |HDnda

Aftribute Narme:

The NMumber of Possible Yalues: |5

hinimum MNumber:

Fuel consumption ;I
k4
Howto Assess | | 0];8
Cancel
baxirmum MNumber:

—
—

Alternative Definition

I
|
Help |
|
|

Adtribiute Definition

Input Assessment Information for Quantitative Attributes with

Uncertainty (Step 1)

After you have entered a number for The Number of Possible Values, click the OK
button and you will then be prompted to enter the values and their associated
probabilities in a window similar to the one shown in Figure 4.4.

made, you may
enter it here.

Table 4.1 Input Assessment Information for Quantitative
Attributes with Uncertainty
Item | Information Values Provided Comments
Requested
1 How to Assess | N/A Press this button to get some help on
how to assess this attribute.
2 The Number of | 2 An integer is required. You may use
Possible Values any number from 1 to 20.
3 Help N/A Press this button to get some help on
how to use this dialog window.
4 Attribute N/A Press this button to find out more
Definition information about this attribute. The
information is stored at the model
building stage (refer to Item 1 of
Table 2.1 or Table 2.2)
5 Alternative N/A Press this button to find out more
Definition about this alternative. The
information is stored when you
defined the alternative earlier (refer
to Section 4.2).
6 Provide If you wish to The information entered may help
Comments explain the other people to understand how the
(for Figure 4.4) | assessment you assessment is made.
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IDS Dialog: Engine y

Alternative Name: |H0nda
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x|
=
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B 03 - oK
YWiorst Attribute YWalue: 143 0.7 I
Cancel |
|25
Adtribute Linit: Help |
R Alternative Definition |
Attribute Definition |

Provide Comments |

Figure 4.4 Input Assessment Information for Quantitative Attributes with
Uncertainty (Step 2)

To input assessment information, depending on the figure you entered earlier, you
need to provide the same number of values in the Possible Value column and the
probability associated with each of the values in the Belief Degree column. For the
motorcycle Honda, the Fuel consumption rate is 43 and 31 miles/gallon on
motorways and urban streets respectively. For the buyer who uses the motorcycle
mainly on motorways (70%), then the assessment data entered should be similar to
those shown in Figure 4.4.

The values you enter must be between the Best Attribute Value and the Worst
Attribute Value. The total belief degrees should be 1 or less. If the total is less than 1,
it means that some of the information is missing (incomplete). Although the program
can accept and process such incomplete information, you are encouraged to identify
as much information as possible to reduce uncertainties in the overall assessment
results.

For details on how to use each of the buttons in this window, refer to Table 4.1.

4.5 Input Assessment Information for Qualitative Attributes

If an attribute is defined as the Qualitative type, double clicking it will bring a dialog
window similar to Figure 4.5.

The figures displayed in the Grade Name column are defined in the modelling stage
(refer to Item 4 in Table 2.1).

To input your assessment of the selected alternative on the attribute, you only need to
tick one or more grades and provide each grade with a belief degree in the Belief
Degree [0, 1] column. You may select a figure from the dropdown list or type in your
own figure.

Note that the total belief degrees (subjective probability) should be 1 or less. If the
total is less than 1, it means that some of the information is missing (incomplete).
Although the program can accept and process such incomplete information, you are
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encouraged to identify as much information as possible to reduce uncertainties in the
final results.

Aftribute Definition

x
Father Attribute |General E
Marne: =
Current Aftribute |Seat comfort =
Marme: R
Grade Definition: [No definition for the grade is provided. =
H
Grade Name: BB“EEDDE%YEE e |
Poorﬂﬂ j | 88 I
Indi]‘ferentﬂ[I j Cancel |
Average [0 e
Good t el |
Excellentﬂ[l 3 Alternative Definition |
|
|

Provide Evidence

Erovide Comments

Figure 4.5 Input Assessment Information for Qualitative Attributes

1DS Dialog: Kawasaki on Seat comfork

Grade definitions:

x|
[l Grade Definitions = oK |
All Grade Definitions
Poor |
Indifferent Lol
Average
Good Help |
Excellent
Good:
o definition for the grade is provided. |
Frovide evidence as follows:
Mo evidence is provided. ;l Capy |
Cut
Paste |
Undo |
2

Figure 4.6 Provide evidence When Input Assessment Information
for Qualitative Attributes

For details on how to use each of the buttons in this window (Figure 4.5) refer to
Table 4.2.

(98]
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Table 4.2

Input Assessment Information for Qualitative

Attributes with Uncertainty

Item Info Values Provided Comments
Requested
1 Grade N/A Depending on which grade name
Definition: the cursor is in the Grade Name
column, the Grade Definition
display area will display more
information about the grade. Such
information acts as assessment
standards to help reduce
inconsistency in subjective
judgements. The information is
entered earlier in the model
building process (See Item 4 in
Table 2.1).
2 How to N/A Press this button to get some help
Assess on how to assess this attribute.
4 Help N/A Press this button to get some help
on how to use this dialog window.
5 Attribute N/A Press this button to find out more
Definition information about this attribute.
The information is stored at the
model building stage (refer to
Item 1 of Table 2.1 or Table 2.2)
6 Alternative | N/A Press this button to find out more
Definition about this alternative. The
information is stored when you
defined the alternative earlier
(refer to Section 4.2).
6 Provide If you wish to record The information entered may help
Evidence evidence used to assess an to convince people that the grades
alternative related to the and their associated belief degrees
attribute, you may press this | you entered in the window shown
button to activate a window | in Figure 4.5 are based on
shown in Figure 4.6 and evidence and are compared with
enter the information in the assessment standards for each
space provided. To help you | grade.
make consistent judgements,
the grade definitions are
displayed in the upper pane
of the window. You may
choose from the dropdown
list to display the definition
for one grade at a time.
7 Provide If you wish to explain the The information entered may help
Comments | assessment you made, you other people to understand how

may enter it here.

the assessment is made.
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5 VIEW RESULTS WITH IDS MULTICRITERIA ASSESSOR

Once assessment information for all bottom level attributes is collected, the overall
performance and the performance for higher level attributes are then calculated by
IDS Multicriteria Assessor using the Evidential Reasoning (ER) approach
automatically. For each attribute, the computed performance information includes not
only an indicative score, but also a performance distribution and uncertainty
associated with the assessment.

You may view the assessment information for any selected alternatives on any
selected attributes in the attribute hierarchy at any time — even when you have not
gathered information for some of the bottom level attributes. In this case the missing
information will be shown in the assessment as uncertainty in terms of performance
score range (Figure 5.2).

There are a number of graphic interfaces for viewing results. In this section, we will
demonstrate how to use the interfaces to view a few commonly used graphics.

5.1 View Performance Scores on Top and Sub Attributes

Performance scores of alternatives on attributes are often used for ranking purposes. If
you wish to compare and rank alternatives, IDS provides a very simple interface to
view performance scores on the top or any sub attributes as follows:

1. Click anywhere in the alternative pane (left pane) of the IDS main window
(Figure 2.8),

2. Click the top attribute or any attribute of interest to you in the attribute
hierarchy once in the right pane, and

3. Click the Wl button in the toolbar at the top of the window. The graph you see
is similar to the one shown in Figure 5.1 (for the Overall Performance
attribute) or Figure 5.2 (for the Engine attribute).

The results in Figure 5.1 or Figure 5.2 display the performance scores for all the
alternatives on the selected attributes. Because there are some missing data in the
assessment information, the graph provides a lower and upper bound of the
performance scores, so that you know that the scores will be in the range marked in
grey whatever the missing data turn out to be.

The table at the lower pane of the window displays the values plotted in the graph.
You may hide the table by dragging down the dividing line just above the table.
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Figure 5.1 Performance Scores on Overall Performance
(Note that if you wish to change any colour in the figure, you can right click the
colour and then select Color to pick up a desired colour from the provided colour
pallet, as shown in Figure 5.1)
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Figure 5.2  Performance Scores on Engine
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5.2 Compare Selected Alternative on Any Selected Attributes

The previous section talked about viewing performance scores of all alternatives on
ONE attribute. This section describes how to view the performance scores of any
selected alternatives on a number of selected attributes. The steps are given below.

1. Click the = button once in the toolbar of the main window (Figure 2.8). This
will bring the graphic window similar to Figure 5.3.

This window displays all the performance scores of all the alternatives on the
top attribute and its immediate child attributes. If there are uncertainties in the
estimates, the lower and upper bound will not be displayed. Instead the
average of the lower and upper bound is calculated and displayed.

If the legend is not shown in the graph, you may right click any blank area on
the graph to display the pop up menu and select the Legend box to display it.

If the data displayed on the graph look crowded, you may wish not to display
them. You can do so by right clicking anywhere on the graph except the data
columns (so that the changes will be applied to all alternatives, not just the
selected one), and then from the pop up menu selecting the Properties.... This
will bring up the chart property window, as shown in Figure 5.4. Select the
Series tab if it is not already selected. Make sure that <<All Series>> is
displayed in the drop down list and then un-check the Show points labels

option.
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Figure 5.4 Handling Graphs Using the Graph Property Window

If you wish to add or remove an alternative from the display, you can click on
the alternative listed in the upper left pane or the A4 List of Selected
Alternatives: dropdown list (Figure 5.3), click the button Select One or
Deselect respectively, and then click the Draw button to redraw the picture.

By clicking the arrow in the A List of the Selected Alternatives dropdown list
(Figure 5.3), you can view which alternatives are selected for the display.

If you wish to add or remove an attribute from the display, you can click on
the attribute listed in the upper right pane or the A List of Selected Attributes:
dropdown list (Figure 5.3), click the button Select One or Deselect
respectively, and then click the Draw button to redraw the picture.

If you wish to select a group of attributes, you can use the Select Group
button. Clicking the button will add the selected attribute and all the attributes
sharing the same father attribute.

By clicking the arrow in the 4 List of the Selected Attributes dropdown list,
you can view which attributes are selected for the display.

. You may use the Clear button to deselect all the alternatives and attributes.
. You may use the Select All button to select all the alternatives and attributes.

. You may click the Toolbar button to show the graphic editing tool box to
change the appearance of the picture.
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5.3 View Performance Diversity Information

Performance diversity information for any alternatives on any attributes is uniquely
provided by the IDS Multicriteria Assessor due to the adoption of the Evidential
Reasoning approach for information aggregation. The distributed performance
information of alternatives on bottom level attributes is preserved and propagated to
the top level attribute in the aggregation process. The distributed information provides
a panoramic view on the diversity of an alternative’s performance.

5.3.1 View Performance Diversity Information for One Alternative

To view the performance diversity information for one alternative on any attribute, do
the following.

1. Click once on the alternative you are interested in, for example, BMW, in the
left pane of the IDS main window (Figure 2.8),

2. Click once on the attribute you are interested in, for example, Overall
Performance, in the right pane of the window, and

3. Click the dll button in the toolbar at the top of the window. The graph you will
see is similar to the one shown in Figure 5.5.
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Figure 5.5 Display Performance Diversity of An Alternative

The information displayed in Figure 5.5 provides more information than just an
average performance score. This picture reveals the distribution of the overall
strengths and weaknesses of the alternative. You may also search where those weak
areas and strong areas locate (see Section 5.3.3). Such information can help the
decision maker to make a more informed choice.
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5.3.2 View Performance Diversity Information for Selected Alternatives

To view performance diversity information for all or selected alternatives on any
attribute, do the following.

1. Click once on the attribute you are interested in, for example, the Overall
Performance, in the right pane of the IDS main window (Figure 5.6),

2. Select from the menu bar of the main window Report -> Graph Belief Degree
->Alternatives (Figure 5.6). This will generate a graph shown in Figure 5.7.
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Note that this type of graph can only be plotted for qualitative attributes. The labels of
the X-axis in the picture are the grades defined at the attribute definition stage (refer
to Item 4 of Table 2.1).

The picture in Figure 5.7 displays the diversity information for all the alternatives.
There is a legend box to help you identify which is which. If the legend box is not
shown, you can right click on any blank area in the picture and then select Legend box
from the pop up menu (Figure 5.3). You may also drag the legend box to where you
want it to be located.

If you wish to exclude some of the alternatives from the display, you may right click
the unwanted alternative and then select Properties... from the pop up menu (Figure
5.3). This will bring the following window as shown in Figure 5.8. From the Series
tab of the window, you need to make sure that the unwanted alternative name is
displayed in the drop down list of the window and then un-tick the Visible option, as
highlighted in Figure 5.8.

The chart property window also provides many other functions for you to change the
appearance of the picture. You can edit all pictures through their property windows.
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Figure 4.8 Compare All Alternatives’ Total Cost Estimates

5.3.3 Search Strengths and Weaknesses for Selected Alternatives
To search strengths and weaknesses for selected alternatives, do the following.

1. Click the E= button once in the toolbar of the main window (Figure 5.6). This
will invoke the graphic window similar to Figure 5.3.

2. If you wish to add or remove an alternative from the search, you can click on
the alternative listed in the upper left pane or the A4 List of Selected
Alternatives: dropdown list (Figure 5.3), click the button Select One or
Deselect respectively.
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By clicking the arrow in the A List of the Selected Alternatives dropdown list
(Figure 5.3), you can view which alternatives are selected for the search.

3. Click on the View What? button at the top of the window (Figure 5.3), so that
the window similar to the one shown in Figure 5. 9 will be displayed. Click
the last radio button to specify that you want to view for the selected
alternatives on all the attributes which have scored either more or less than a
specified score. When you have made the selection, click the View button. For
example, if you specify to View any attributes better that 0.5 each for all the
selected alternatives, and Honda and BMW are the selected alternatives, you
will see a picture similar to the one shown in Figure 5.10.

5.3.4 Compare Differences and Similarities between Two Alternatives

To search and compare differences and similarities between two alternatives, do the
following.

1. Click the E= button once in the toolbar of the main window (Figure 5.6). This
will invoke the graphic window similar to Figure 5.3.

2. Add or remove alternatives by clicking on the alternative listed in the upper
left pane or the A List of Selected Alternatives: dropdown list (Figure 5.3),
and clicking the button Select One or Deselect respectively. Check that only
two alternatives are selected by clicking the arrow in the 4 List of the Selected
Alternatives: dropdown list (Figure 5.3). If not, use the Select One or Deselect
button to add or remove alternatives from the selected list.

3. Click on the View What? button at the top of the Window (Figure 5.3), so that
the window similar to the one shown in Figure 5. 9 will be displayed. You
may specify what you want to view by clicking the third radio button. You
may specify whether you what to see the differences or similarities between
the two and by how much. When you have made your selection, click the View
button. The selection in Figure 5.9 will display all areas where Yamaha and
BMW are scored very differently, with at least 50% between the scores in
each area (attribute). The outcome of the search is shown in Figure 5.11.
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Figure 5.9  Search and Compare Differences and Similarities
between Two Alternatives
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6 SENSITIVITY ANALYSIS

Decision maker are often interested in examining how changes in attribute weights
and alternative performances on an attribute affect the overall ranking of alternatives.
This is the purpose of sensitivity analysis.

When there is missing information in alternative assessments, the score ranges
generated by the ER approach, such as the ones shown in Figure 5.1 and Figure 5.2,
are the outcomes of a kind of global sensitivity analysis carried out on the possible
ranges of missing information.

On top of score ranges, IDS also provide 3 other types of sensitivity analysis: Chang
Weight, Change Input Data and Trade-Off Analysis. They are described below.

6.1 Sensitivity Analysis on Change of Weight

To conduct sensitivity analysis on change of weight, do the following.

1. Click once on the attribute you are interested in changing its weight, for
example, Engine, in the right pane of the IDS main window (Figure 6.1),

2. Select from the menu bar of the main window Sensitivity -> Change Weight
(Figure 6.1). This will invoke a graphic window shown in Figure 6.2.
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- Operation o
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Depict the changes of the scores or belief degrees of alternatives caused by changing weights of an 4

Figure 6.1 Menu Selection for Sensitivity Analysis

3. To see the effect of changing the weight for Engine, you need only to drag and
drop the bar corresponding to the Engine’s weight in the lower left pane of the
window (Figure 6.2) to the desired height. The scores of all the alternatives on
Overall Performance change accordingly and are dynamically updated in the
lower right pane of the window.
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There are various options in this window to allow you to select alternatives and
attributes. You can also choose weights of other attributes to change and use different
types of graph for the analysis. The details are described below.

6.1.1 Select Alternatives to View Ranking

If you are only interested in the ranking of a number of alternatives, you may add or
remove alternatives displayed in the lower right pane of the window by clicking on
the alternatives listed in the upper left pane or the A List of the Selected Alternatives:
dropdown list (Figure 6.5), and then clicking the button Select One or Deselect One
respectively. Check that the alternatives listed in the A List of the Selected
Alternatives: dropdown list are what you are interested in.

6.1.2 Select Attributes on Which to Rank Alternatives

If you wish to add or remove attributes in the lower right pane of the window, so that
you can examine the rankings of the selected alternatives on these attributes, you
should first make sure the radio button (on the right) Click this button if you want to
Select attributes on which to rank alternatives is selected. Then you can click on the
attributes listed in the upper right pane or the A List of the Selected Attributes:
dropdown list (Figure 6.2), and click the button Select One or Deselect respectively.
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6.1.3 Select Attributes for Changing Weights

If you wish to add or remove attributes in the lower left pane of the window, so that
you can change weights for the attributes, you should first make sure the radio button
(on the left) Click this button if you want to select attributes for Changing weights is
selected. Then you can double click on the attribute you wish to select from the upper
right pane (Figure 6.2). As soon as you double click on the attribute, the weights for
the attribute and the other attributes in its group, which share the same father attribute,
will be displayed in the lower left pane of the window. You may use the mouse to
drag and drop the edge of the bars to change the weights of the attributes and see the
effects of the changes in the lower right pane.

The weights displayed can be normalised. Click the Normalise button to get the
weights normalised and click on the button again to cancel the normalisation.

6.1.4 Select Different Types of Sensitivity Analysis Graphs

There are three types of graphs for you to choose from: Ranking, Belief Degree and
Rank Change. By default, the Ranking type (shown as in Figure 6.2) is displayed. If
you click the Rank Change button at the top of the window, the graph type will
change to the one shown in Figure 6.3. If you click the Belief Degree button at the
top of the window, the graph type will change to the one shown in Figure 6.4.
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You may choose any type of the graphs according to your requirement. All graphs
will respond dynamically to any changes you make to the attribute weights displayed
in the lower left pane. Note that the ER approach is a nonlinear aggregation method
and the nonlinearity is shown in Figure 6.3.

6.2 Sensitivity Analysis on Change of Input Data
To conduct sensitivity analysis on change of input data, do the following.

1. Click once on an alternative, for example Honda, in the left pane of the IDS
main window (Figure 6.1) to select it.

2. Click once on the attribute in the right pane of the IDS main window (Figure
6.1) on which you wish to change the assessment data for the selected
alternative. The attributes have to be at the bottom level of the hierarchy, for
example, Quietness, in the right pane of the IDS main window (Figure 6.1),

3. Select from the menu bar of the main window Sensitivity -> Change Input
Data (Figure 6.1). This will generate a graph shown in Figure 6.5.

4. To see the effect of changing the assessment data for the selected alternative
on the selected attribute, you need only to change the assessment input by
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dragging and dropping the bars (from the top edge or zero level if the belief
degree is 0.00 and the bar is not shown) corresponding to the belief degrees of
the assessment grades for the attribute if it is of a qualitative type (Figure 6.5)
or the attribute value if it is of a quantitative type (Figure 6.6). The scores of
all the alternatives on the selected attribute change accordingly and are
dynamically updated in the lower right pane of the window.
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Figure 6.6 Ranking Sensitivity Analysis on Change of
Input Data for Quantitative Attributes

There are various options in this window to allow you to select any alternative and
any bottom level attribute for changing input data through the lower left pane of the
window (Figure 6.5 or Figure 6.6). You can also choose any attribute or a number of
attributes from different levels in the hierarchy on which to view the ranking changes
simultaneously.

6.2.1 Select Alternatives to View Ranking

If you are only interested in the ranking of a number of alternatives, you may add or
remove alternatives displayed in the lower right pane of the window by clicking on
the alternatives listed in the upper left pane or the A List of the Selected Alternatives:
dropdown list (Figure 6.5), and then clicking the button Select One or Deselect One
respectively. Check that the alternatives listed in the A List of the Selected
Alternatives: dropdown list are what you are interested in.

6.2.2 Select Attributes on Which to Rank Alternatives

If you wish to add or remove attributes in the lower right pane of the window, so that
you can examine the rankings of the alternatives on these attributes, you should first
make sure the radio button (on the right) Click to Select attributes on which to Assess
alternatives is selected. Then you can click on the attributes listed in the upper right
pane or the 4 List of the Selected Attributes: dropdown list (Figure 6.5), and click the
button Select One or Deselect One respectively.
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6.2.3 Change Selection of Attribute for Changing Input Data

From the window shown in Figure 6.5, you may select any bottom level attribute for
changing input data for a selected alternative. Changing the selection of an alternative
is discussed in the next section.

If you wish to change the assessment information for the attribute currently displayed
in the lower left pane of the window, you should first make sure that the radio button
(on the left) Click to Select attributes for Changing input Data is selected. Then you
can double click on the attribute you wish to select from the upper right pane (Figure
6.5). As soon as you double click on the attribute, the assessment information for the
selected alternative on the attribute will be displayed in the lower left pane of the
window. You may use the mouse to drag and drop the edge of the bars to change the
input data and see the effects of the changes in the lower right pane.

6.2.4 Change Selection of Alternative for Changing Input Data

To change the selection of alternative for changing input data on the selected attribute
is simple. You need only to click once on the bar corresponding to the alternative in
which you are interested in the lower right pane of the window (Figure 6.5). If the
alternative is not shown in the pane, you may follow the instruction described in
Section 6.2.1 to add it on in the lower right pane of the window.

6.3 Trade-Off Analysis

Trade off analysis is to compare all alternatives on two attributes, usually one cost
related attribute and the other benefit related attribute. Therefore, the trade-off
analysis is sometimes called cost-benefit analysis. The picture will visually display
any best value options and worst value options.

To conduct the analysis, do the fowling:

1. Click once on an attribute in any level of the attribute hierarchy, for example
Price, in the right pane of the IDS main window (Figure 6.1).

2. Click once on another attribute in the hierarchy.

3. Click the = button from the toolbar of the main window (Figure 6.1). This
will invoke the graphic window shown in Figure 6.7.

Note that the attribute selected first (in step 1) will be on the X-axis in the graph and
the second attribute on the Y-axis.
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Figure 6.7 Trade-Off Analysis
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7 ADVANCED FUNCTIONS

This section describes several other functions in IDS which may help you save time
and effort during modelling, data collection and data output processes. Although they
are called advanced functions, they are not necessarily difficult to learn.

7.1 Compare Results Using Different Models

Experts may do their estimates separately in their own computers. They may use the
same cost model (including hierarchy and attribute definitions). They may also use
different models. How to compare the estimates made by different experts side by
side? We will look at two cases below.

7.1.1 Compare Results Using the Same Model Structure

If you have two or more IDS Multicriteria Assessor files (with extension .ids) and
they have the same model structure, you can import the alternatives from one file to
another file. To do it, you need to

1. Open the .ids files and make sure that all alternative names in different files
are different from each other. If they are the same, the data may be over-
written by the imported file;

2. Click once on any of the alternatives listed in the left pane. If you leave
the cursor in the right pane on any of the attributes, the view of the
alternative list will not be updated automatically after importing.
However, you may manually update the view by clicking any alternative
and then clicking the £ icon in the toolbar.

3. Select from the menu bar in the program main window Input -> Add Data
from IDS File, and then from the window similar to Figure 2.9 browse and
select the file you wish to import. Once you have selected the file and press
the Add button, the alternatives in the selected file will be added to the current
window,

4. Save the file in another name from the menu bar in the program main window
File->Save A4s...

7.1.2 Compare Results Using Different Model Structures

If the models in different files are completely different, the data in the two files can
not be compared directly. It makes sense to only compare things with some similarity.

If you have two or more .ids files and they have different model structures to certain
degrees, you may still be able to import the alternatives in one file to another by
following the steps in the previous section. The importing function will import the
alternatives and their data on the attributes that are common to both models.
Therefore you should always import the alternatives of a more detailed model --
a model with more sub attributes, into a less detailed model. This is because the
attribute hierarchy of the less detailed model is common to both models.
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When importing, you should make sure that the Best Value and Worst Value are the
same for the common quantitative attributes in both the current .ids file (container
file) and the imported .ids file.

7.2 Save the Model and Data in Text File

If you wish to save the model and the assessment information for an alternative in text
format, you can do so by

1. Clicking the alternative you want to save from the left pane of the program
main window,

2. Clicking from the menu of the window Report->Save in Text File ->
Alternative (Figure 7.1). This will bring a window similar to the one shown in
Figure 7.2,

If you wish to save only the model structure (the hierarchy), you can select the second
radio button and then clicking the Start Saving button (Figure 7.2). If you wish to
save the data for the selected alternative, you can select the first radio button, and then
from the enabled list below, select what you want to save.

The text may not be in the exact format you want and you may need to edit them for
your reporting purposes.

You may also save all the alternative estimates on one selected attribute by clicking
the Report->Save in Text File -> Attribute (Figure 7.1) menu in the program main
window.
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If you wish to use a graph in presentations or reports, you can left click the button
in the graph toolbar at the top of the graph window (as shown in Figure 7.3), from the
pop up menu select As a Bitmap (or As a Metafile), and then paste it into your power
point or word documents.

7.3.2 Change Colours

If you wish to change any colour in a graph, you can right click the colour you want
to change, from the pop up menu select Color and then pick up a desired colour from
the provided colour pallet, as shown in Figure 5.2.

7.3.3 Change Font

If you wish to change any font in a graph, you can right click the text for which you
want to change the font, from the pop up menu select Font... and then pick up a
desired font from the provided font changing window.

7.3.4 Change Graph Titles, Titles for X-Axis and Y-Axis

If you wish to change the text in a graph titles and the titles for X-Axis or Y-Axis, you
can right click the title you want to change, from the pop up menu select Edit Title
and then type the text you want in the space provided.

7.3.5 Change the Appearance of a Graph

If you wish to change any part of the Graph Titles, you can right click the place you
want to change, from the pop up menu select Properties...and then use the provided
chart properties window to make the change (Figure 5.4 and Figure 5.8).

You can also use the graph toolbar at the top of the graph window to change the style
of the graph, add or remove gridlines, switch between 3-D and 2-D, and print the
graph.

7.4 Aggregating A Group of Alternatives

To aggregate the assessments of several alternatives, you need to create a Group
alternative by following the steps below.

You can create a group alternative by clicking in the alternative pane and then the
Modelling -> Alternative -> Create Group Assessment menus (Figure 7.4). This will
activate a window similar to Figure 7.5.

You can select and deselect any alternatives to form the group alternative. You may
also change the weight of any of the alternatives selected. The dropdown list in the
window will display which alternatives are included in the group.

For the aggregated group alternative, the belief degrees associated with the grades or

the value of each bottom level attribute are the weighted average of the belief degrees
or the values of the alternatives in the group on the attribute.
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APPENDIX COMPARE ER APPROACH WITH AHP

People who know AHP method often ask what are the differences between the ER
approach and the AHP method. Although both ER and AHP use hierarchical structure
to model a MADA problem, ER differs from AHP in the following ways.

1.

In the ER framework, alternatives are not in the hierarchical structure, while in
AHP all alternatives consist of the bottom level of the hierarchy.

ER approach uses a belief decision matrix to model a MADA problem. Each
element of the matrix is a distributed assessment in forms of the belief structure.
In a conventional decision matrix, each of its element is a single number. In AHP,
the decision matrix becomes a pairwise comparison matrix with each element
describing the relative importance of an attribute over another attribute or the
relative preference of an alternative over another alternative.

ER wuses the Evidential Reasoning approach to aggregate the distributed
assessments of the lower level attributes to higher level attributes progressively.

AHP and many other methods based on the additive value/utility function
approach that requires the attributes of a MCDM problem to satisfy the additive
preferential independence condition. Such a condition limits the scale of MCDM
problems those methods can handle. ER approach does not require such a
condition and can handle large scale MADM problems. There is no limit on the
number of attributes in the IDS hierarchy or on the number of alternatives to be
assessed. For example, IDS has been used for conducting organisational self-
assessment, which includes 3 levels of criteria. There are 9 criteria in level 1, 32 in
level 2, and 210 in level 3. IDS can handle it easily with a 256 MB RAM PC. It
would be a daunting task for AHP.

IDS can assess newly added alternatives independently. Because IDS calculates a
ranking score for an alternative independently, when new alternatives are
presented to IDS, IDS does not need to re-evaluate the previously assessed
alternatives. AHP, on the other hand, is based on pairwise comparisons. When
new alternatives are presented to AHP, the assessments done on the old
alternatives have to be abandoned. A new assessment procedure has to be started
taking into account all the old and newly added alternatives.

IDS produces consistent rankings after new alternatives are added into the
assessment procedure. It is known that the use of AHP may lead to problems like
rank reversal, that is, the introduction of new alternatives for assessment may
cause the unexpected and irrational change of the rankings of the current
alternatives.

In addition to generate a score for each alternative, IDS produces a distributed
assessment. The distributed assessment gives the decision maker an idea of the
diversity of the performance of an alternative.

IDS can handle mixed information with uncertainties in the same ER framework.
The mixed information includes deterministic, random, qualitative and incomplete
or missing data for some attributes.

IDS also uses the pairwise comparison method as one of its weighting elicitation
methods.
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